Publication Information

Publication date 
February 29, 2008
Printed in U.S.A.

Copyright notice
Partial Copyright © 2008 McKesson Corporation and/or one of its subsidiaries. All Rights Reserved.

This documentation and the related software are governed by a license agreement and remain the property of McKesson Provider Technologies, a wholly owned subsidiary of McKesson Corporation (McKesson). Except as permitted by the license agreement, no part of this documentation or the related software may be used, reproduced, translated, displayed, distributed, disclosed, stored in a retrieval system, or transmitted in any form or by any means without the prior written permission of McKesson Corporation. This documentation contains confidential proprietary and trade secret information of McKesson Corporation and is protected under United States and international copyright and other intellectual property laws. This documentation and the related software are subject to change without notice.

Release
Pathways Materials Management, 9.0

The content included in this guide was determined in a joint venture between McKesson Provider Technologies Customer Education Solutions and University of Rochester.

Trademarks

All other product and company names may be trademarks or registered trademarks of their respective companies.

Disclaimer
The names used in this publication are not the names of real individuals. Any similarity or likeness of the names used in this publication with the names of actual persons is purely coincidental and not intentional.
# Table of Contents

## Chapter 1 - Getting Started

- Objectives ............................................. 1-2
- Pathways Materials Management System Basics ................. 1-3
  - The PMM Windows .................................. 1-4
  - The PMM Login Window ......................... 1-5
  - Using Help ........................................ 1-7

## Chapter 2 - Requisitioning

- Objectives ............................................. 2-2
- Overview ............................................ 2-3
- Creating Requisitions ................................ 2-4
  - Adding a Non-Catalog Item ...................... 2-9
  - Entering Allocations ......................... 2-11
- Querying a Requisition .......................... 2-12
- Requisition Approvals .......................... 2-15
  - Approval History ............................... 2-17

## Chapter 3 - Queries

- Objectives ............................................. 3-2
- Monitoring PO Progress .......................... 3-3
  - Purchase Order History ....................... 3-11
- Vendor Editor ..................................... 3-12
  - Query a Vendor .................................. 3-13
- Item Manager ..................................... 3-16
  - Query an Item ................................... 3-19

## Chapter 4 - Receiving

- Objectives ............................................. 4-2
- Receiving Process .................................. 4-3
  - Step 1: Open a Purchase Order .................. 4-5
  - Step 2: Verify and Edit Receive Quantities ......... 4-7
  - Step 3: Save the Receipt ........................ 4-10
  - Step 4: Deliver the Items ...................... 4-11
- Processing Overshipments ....................... 4-12
- Entering Line Notes ................................ 4-13
- Killing / Unkilling Partial PO Lines ............. 4-14
- Entering Returns for Vendor Replacement ........... 4-15
- Entering Returns for Vendor Credit .............. 4-16
- Receiving in Alternate Units of Measure .......... 4-17
- View Receipt History .............................. 4-19
- View Purchase Order Activity .................. 4-20
Chapter 5 - Resolve Invoice Discrepancies .............................................. 5-1
  Objectives ...................................................................................... 5-2
  Resolving Invoice Discrepancies ................................................. 5-3
    Assess the Problem .................................................................... 5-5
    Resolve the Problem .................................................................. 5-8
    Approve the Invoice .................................................................. 5-9
    Routing Discrepant Invoices ...................................................... 5-10

Chapter 6 - Generating Reports .............................................................. 6-1
  Objectives ...................................................................................... 6-2
  Generating a Receiving Report .................................................... 6-3
    Selecting Extract Values ......................................................... 6-5
    Selecting Sort Options .......................................................... 6-7
    Report View ............................................................................. 6-9
    Exporting Results .................................................................... 6-10

Chapter 7 - Purchasing ............................................................................ 7-1
  Objectives ...................................................................................... 7-2
  Creating Purchase Orders ............................................................ 7-3
    Entering Catalog Items ........................................................... 7-10
    Enter Non-Catalog Items ......................................................... 7-15
    Pulling Requisitions on to a Purchase Order ............................ 7-17
    Resubmitting a PO ................................................................. 7-19
    Adding Line Allocations to a PO ............................................. 7-21

Chapter 8 - Requisitioning Profiles .......................................................... 8-1
  Objectives ...................................................................................... 8-2
  Overview ...................................................................................... 8-3
  Requisition Profiles ..................................................................... 8-4

Chapter 9 - Par Forms ............................................................................. 9-1
  Objectives ...................................................................................... 9-2
  Overview ...................................................................................... 9-3
  Manual Process ......................................................................... 9-4
    Manual Process Detail ............................................................ 9-5

Chapter 10 - Supply Location Information .............................................. 10-1
  Objectives ..................................................................................... 10-2
  Supply Location Information ....................................................... 10-3
Chapter 1 - Getting Started
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:

- identify the applications within Pathways Materials Management
- log in and out of the Pathways Materials Management applications
- change your password
- access on-line Help.

Important:

Attention students: In the event you happen to see confidential patient information in this training, the University of Rochester would like to remind you that we are all bound to keep Patient Health Information private and secure. Additionally, if you see something on the screen that makes you uncomfortable, please let your instructor know and we will use different data.
Pathways Materials Management System Basics

Overview

The following flowchart illustrates a request for supplies through the PMM system.
The PMM Windows

PMM Desktop

The following shows the components of the PMM desktop:

```
<table>
<thead>
<tr>
<th>Administration</th>
<th>Contract Manager</th>
<th>Editors</th>
<th>Fax Viewer</th>
<th>GL Explorer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Management</td>
<td>Invoice Matching</td>
<td>Item Manager</td>
<td>Par Level</td>
<td>PO Scheduler</td>
</tr>
<tr>
<td>PO Viewer</td>
<td>Purchasing</td>
<td>Receipt Accrual ...</td>
<td>Receiving</td>
<td>Requisitioning</td>
</tr>
<tr>
<td>Template Maintenance</td>
<td>View 810</td>
<td>View 832</td>
<td>View 856</td>
<td></td>
</tr>
</tbody>
</table>
```
The PMM Login Window

Logging in
To log into PMM Requisitioning, either double-click the Requisitioning icon found in your PMM desktop folder or from the Start menu, select Pathways Materials Management and then click Requisitioning.

Result: The PMM Password Manager window displays.

![PMM Password Manager Window]

Enter your User ID (Domain ID) and Password, then click Enter.

**Important:** Every user must have a unique User ID and a Password to login to Pathways Materials Management.

The security groups to which your User ID is assigned determine your access rights within Pathways Materials Management applications.

Logging Out
To log out of PMM, click the X in the upper right hand corner of the application. See Password Time-out on the next page.
The PMM Login Window, continued

Status Bar

When you right-click the PMM button on the Windows Status Bar, a menu displays. You may then close (log out) or click **About** to see the PMM version number and database information.

Password time-out

Your login remains active for the amount of time set by your system administrator after you close all Pathways Materials Management applications. Standard period of inactivity for University of Rochester is 30 minutes.

This allows you to open and close frequently used applications without logging in again. Note: Closing Password Manager when other applications are open is not recommended. You risk losing unsaved data.

Change Password

If you have appropriate privileges, you can change your password in the Password Manager.
Using Help

Accessing Online Help

On-line Help allows you to have immediate access to application documentation. You can access the Help option within any PMM application.

You can search by **Topic** or click **Search** and type a word or phrase to locate information.

There are several ways to access Online Help within a PMM application:

- click **Help** on the menu bar and then **Help Topics**
- click the question mark on the menu bar or
- press **F1**.

Result: The Help Topics window displays.
Using Help, continued

Help Categories

Topics fall into one of several categories:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procedures</td>
<td>Drill to module’s step by step procedures. Print the step by step instructions as a quick reference for end-users.</td>
</tr>
<tr>
<td>Concepts</td>
<td>Definitions and theory for selected topics. Click topic and it presents a list of similar topics on the left side of the screen. Click the one you want and review the information.</td>
</tr>
<tr>
<td>Administration</td>
<td>Reference information about Editors, Security, Integration, and PMM Utilities.</td>
</tr>
</tbody>
</table>

You can access Online Help either locally or via the network depending upon your workstation installation.

To view Online Help, at a minimum you need a browser on the workstation. Note: You do not need internet access to use Online Help.

When using the Search capability, click Search, then type the word or phase you wish to find. Drill through the information results. When finished, click Back or Close to return to the main Online Help window.

An advantage of the HTML user documentation site is the ability to customize end-user documentation for your organization using a common HTML authoring tool. Reference the Using the Documentation Site guide for more information.
Chapter 2 - Requisitioning
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:

- launch and exit PMM Requisitioning
- order off a template
- create and submit requisitions
- query requisitions
- view and approve requisitions for non-Orion users.
Overview

A general requisition follows this process:

New Requisition or Template is created

Items are added and the Requisition is submitted

Stock items

Not applicable for this class

Non-Stock / Non-Catalog items

Supply Location

Purchasing

Vendor

AUTOPO
Creating Requisitions

Introduction

Requisitions can be created by ordering off of a template or building a new requisition.

Steps

Follow the steps below to order items off a requisition template:

1. Open Requisitioning.
2. Log in with your User ID and Password.
3. Select a template. (Same as “custom requisition” in ESI NOVA)
   Note: If you are not using a template, click the New Requisition icon.

4. Verify the Requisition Header information.
5. Enter quantities for the items you are requesting.
   Note: You can add other items to your requisition if desired.

6. Submit the requisition using the Submit icon.
   Note: Save the requisition as a draft if it is not ready to be submitted.
Creating Requisitions, *continued*

**Steps 1 through 2 - Logging in**

1. Open **Requisitioning**.
2. Log in with your User ID and Password.

   **Result:** The Requisitioning window displays listing the available templates associated with your cost center security rights.

**Step 3 - Select a template or click New Requisition**

Double click on your template or click the **New Requisition** icon to create a new requisition.

Note: To change the display order, click a column header.

**Step 4 - Verify Requisition Header Information**

The Requisition Header Information contains general information about the requisition.

1. Verify the information defaulting in the fields. Make changes as needed.
2. Enter a Header Note if needed.
3. Click **OK** to move to the next screen.
Creating Requisitions, continued

Requisition Header fields

The table below describes the Requisition Header fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header bar</td>
<td>Contains the Requisition number (when submitted), requisition creator, request date, and status.</td>
</tr>
<tr>
<td>Deliver To</td>
<td>Location where requested items are delivered.</td>
</tr>
<tr>
<td>Corporation and Cost Center</td>
<td>Corporation and cost center to be charged. Note: Addresses with SL in the name are Stockless addresses and should not be used when creating a new requisition.</td>
</tr>
<tr>
<td>Header Notes</td>
<td>Notes that apply to the entire requisition.</td>
</tr>
</tbody>
</table>

Step 5 - Entering quantities

Go to the lines you wish to order. Enter the quantity in the Order Qty column.

To add a new item to your requisition:

1. Go to the last line in the list and click the arrow down button or use the Insert Line button.
   - Result: A new line displays.

2. Enter the item number or use the Search button to find an item.

3. Enter the quantity.

Hints: To sort requisition lines on a template, go to the Options menu, click Order by, and then select either Line No, Item Number, or Item Desc.
Creating Requisitions, continued

Requisition toolbar

Tasks can be executed by using the Menu bar or toolbar.

Some of the key buttons include; Submit, Go To, Search and Line Detail.

Requisition lines

The requisition line contains the following columns of information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line note</td>
<td>A push pin icon displays when a line note is present.</td>
</tr>
<tr>
<td>Line number</td>
<td>The requisition line number.</td>
</tr>
<tr>
<td>A</td>
<td>Allocation flag. Indicates line is allocated to multiple cost centers.</td>
</tr>
<tr>
<td>Stockless</td>
<td>Indicates the item is a stockless item.</td>
</tr>
<tr>
<td>Item No &amp; Description</td>
<td>Item number catalogued in the Item Manager. Description is populated when item number is selected.</td>
</tr>
<tr>
<td>Order Qty</td>
<td>Desired order amount.</td>
</tr>
<tr>
<td>Active Order Qty</td>
<td>Total of all open stock orders and backorders for the item.</td>
</tr>
<tr>
<td>UM</td>
<td>Unit of measure for the item. Defaults to order UOM.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the line.</td>
</tr>
<tr>
<td>Cost and Ext Cost</td>
<td>Cost is the price pulling from the Item Manager. Ext Cost is the quantity x cost.</td>
</tr>
<tr>
<td>Stocked</td>
<td>Indicates stocked items with a red check mark.</td>
</tr>
</tbody>
</table>

Hint: To sort requisition lines on a template, go to the Options menu, click Order by, and then select either Line No, Item Number, or Item Desc.

Note: UR and HH are not using Fixed Assets, Projects, or Subledger.
Creating Requisitions, *continued*

**Adding line notes**

From the **Line** menu, click **Notes**.

*Result:* The Line Note window displays.

Enter the note, then click **Close** to save and close the window.

*Note:* Click the Push Pin button to keep the line note open while viewing other lines.

*CAUTION:* Adding a line note to a requisition will prevent the order from being sent via AUTOPO. Instead it will be routed to Purchasing for processing.

---

**Step 6 - Submitting the requisition**

When you are ready to send your request, click **Submit**.

*Result:* The requisition is assigned a requisition number and depending upon its approval path, it is either Pending Approval or ready to be processed.

---

**Other tasks**

- To delete a line, select **Delete** from the **Line** menu.
- To insert a line, select **Insert** from the **Line** menu.
- Double-click the line to view the Item Information.

*Note:* These tasks can also be performed using the buttons or the right-click menu.
Adding a Non-Catalog Item

Introduction
With the proper security, requisitioners can order Non-Catalog Items to a requisition.

Steps
1. Open Requisitioning.
2. Select New Requisition.
3. Enter Requisition Header information.
4. Double-click on a blank line and click the Non-Cat check box.
5. Enter the required fields: Quantity, Description, Unit of Measure, Vendor, Expense Account, Cost, Deliver To, and Cost Center.
6. Click Close when done.

Hints:
To replicate a Non-Catalog item, select the Non-Catalog line, then from the Line menu, click Replicate.
Note: Any Allocations or Components from the original line are copied to the new item.
Adding a Non-Catalog Item, *continued*

Non-Catalog validation

Whenever a Non-Catalog item is added to a Requisition, PMM compares the Vendor Catalog Number to the Vendor Catalog Numbers in the Item Manager.

If a match is found, PMM asks if you want to use the item from the Item Manager.

Click **OK** to replace the Non-Catalog item with the Catalog item.

Click **Cancel** to continue with the Non-Catalog item.

You should select the Catalog item in place of the Non-Catalog item whenever applicable.

Department should follow the PMM Requisitioning Guidelines on the Corporate Purchasing website as far as purchases that can be made through PMM.
Entering Allocations

Introduction

The cost of a line can be allocated across multiple cost centers.

Steps

1. Double click on the line to be allocated, then go to the **Line Allocations** tab.
2. Click the Allocations check box.
   
   **Result**: The GL account currently assigned to the line fills in at 100%.
3. Change the allocation percentage or dollars for the default GL account.
4. Click **Add** to add another allocation to the line.
5. Enter another GL account then enter either the cost percentage or dollars.
6. Repeat steps 5 and 6 for each allocation line.
7. Click **Close** when done.

Note: All allocations must add up to equal 100% of the original line.
Querying a Requisition

Introduction

To find a submitted requisition, access the **Query** tab.

![Query Tab Screenshot]

Enter the appropriate search information into the Where field and Created After field, then click **Search**.

Click **Advanced** to search for the requisition by more criteria elements.

**Hints:**

To change the **Created After** default date, open a requisition, go to the **Options** menu, select **Query**, then change the **Days since Requisition was created** number.

Click **OK** when done.

**Result:** The Created after date defaults to the new value.
Querying a Requisition, continued

Requisition status

Following are the requisition statuses:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The requisition has been completely approved.</td>
</tr>
<tr>
<td>*Approved</td>
<td>At least one line has been denied via the approval process.</td>
</tr>
<tr>
<td>Pending Approval</td>
<td>Contains items that require approval. Note: Applicable for Orion users that currently have approval paths built.</td>
</tr>
<tr>
<td>Open/Draft</td>
<td>The requisition has not been submitted.</td>
</tr>
<tr>
<td>Pending Bid</td>
<td>Requisition has been routed to Contract Manager for vendor bidding. Future use for University of Rochester.</td>
</tr>
<tr>
<td>Removed</td>
<td>Draft requisition has been deleted or a submitted requisition where all lines have been denied via the approval process.</td>
</tr>
</tbody>
</table>
Querying a Requisition, *continued*

**Line status**

The following table describes the requisition line statuses:

<table>
<thead>
<tr>
<th>Line status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>The line has not been submitted for approval.</td>
</tr>
<tr>
<td>Pending Approval</td>
<td>The line has been submitted but the dollar amount has not been approved.</td>
</tr>
<tr>
<td>Pending Commodity</td>
<td>The line has been submitted but the commodity code has not been approved.</td>
</tr>
<tr>
<td>Denied</td>
<td>The line has been removed from the order.</td>
</tr>
<tr>
<td>Open Stock Order</td>
<td>The line has been routed to a Supply Location for picking.</td>
</tr>
<tr>
<td>Pending Stock Order</td>
<td>The line has been ordered before the assigned Order Day and has been routed to the Supply Location.</td>
</tr>
<tr>
<td>Backordered</td>
<td>The line has been backordered due to insufficient stock in the Supply Location.</td>
</tr>
<tr>
<td></td>
<td>Note: The status of backorder displays on a Non-Stock item that has been partially received.</td>
</tr>
<tr>
<td>Pending PO</td>
<td>The line has been completely approved and has been routed to the purchasing department to be placed on a purchase order or it is pending processing via AUTOPO.</td>
</tr>
<tr>
<td>On Order</td>
<td>The line has been placed on a purchase order.</td>
</tr>
<tr>
<td>Killed</td>
<td>The line has been killed or partially killed due to insufficient stock in the Supply Location.</td>
</tr>
<tr>
<td>Complete</td>
<td>No further action needed for this line.</td>
</tr>
</tbody>
</table>

Reference Online Help for more information on line statuses.
Requisition Approvals

Requisition Approval Paths

Cost Centers can have multiple Approval Paths. They can be based on item order types.

If a requisitioner has appropriate security rights, you can change the approval path the requisition follows.

When a user changes an approval path on the Requisition Header window and submits the requisition, then the system considers the action as that user’s approval in the new approval path. The system routes the requisition to the first approval level users of the new approval path where the user is not in the new approval path.
Requisition Approvals, continued

Review and approve requisition lines

Security rights determines your ability to review and approve requisition lines. The following tables describes approval tasks:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>approve an entire requisition without reviewing its contents,</td>
<td>from the Requisition Pending Approval tab, right-click the requisition and select Approve/Submit.</td>
</tr>
<tr>
<td>review requisition contents and then approve the entire requisition,</td>
<td>go to the Pending Approval tab, double-click the requisition, review/edit the header information, review requisition lines, edit lines as needed, then Submit the requisition.</td>
</tr>
<tr>
<td>deny individual lines and approve the rest of the requisition,</td>
<td>go to the Pending Approval tab, double-click the requisition, review/edit the header information, right-click the line(s) you wish to deny and select Deny, then Submit the requisition.</td>
</tr>
</tbody>
</table>

Type of changes the Approver may make:

- change the quantity of an item
- change the deliver to, cost center and/or corporation
- change project and sub-project codes
- change/add notes
- deny a line
- add or remove lines (need specific security)
- change the UM of an item (need specific security)
- change the approval path (need specific security)
- approve the requisition by submitting it.
Approval History

Introduction

Approval history is available after a submitted requisition has a status of **Pending Approval**. You can view requisition or allocation approval history by clicking **Approval History** from the Requisition’s **Information** menu, then select **Requisition**.

Result: The Approval History - Requisition window displays.

Approval history displays the cost center and the approval path the requisition has followed, the users who approved the requisition with date and time, and the users who still need to approve the requisition.

Click **Close** when done.
Chapter 3 - Queries
Objectives

Learning Goals
Upon successful completion of this chapter, you will be able to:

- query for a submitted purchase order
- print a purchase order
- query vendors in Vendor Editor
- query items in Item Editor.
Monitoring PO Progress

PO Query

In order to find a PO that you have already submitted, click the Query tab from the Purchase Order Selection window. If you would like to search for the PO using one piece of information, such as the PO number or the cost center, use the Basic search. This feature is similar to POINFO in ESI NOVA.

Steps

1. Select the type of information that you would like to search by in the Where field.
2. Enter your search criteria in the Begins with value field.
3. Select a date that the PO was created after in the Created after field.
   Note: Delete the date field, if the date is unknown.
4. Click Search.
   Result: All POs that meet your search criteria display.
Monitoring PO Progress, continued

Advanced PO Query Search

If you would like to search for the PO using multiple pieces of information, such as the Expense Code, the Cost Center, and an Item Number, select Advanced Search.

The table below describes the field’s function:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Search Field</td>
</tr>
<tr>
<td>2</td>
<td>Operation</td>
</tr>
<tr>
<td>3</td>
<td>Compare to</td>
</tr>
</tbody>
</table>

- **Search Field**: The type of information for which you would like to search by. Select from drop down list.
- **Operation**: Begins with, Greater than, Equal to, and so forth.
- **Compare to**: The information you define for your search. Type in your values and click **Search**. Note: This field is case sensitive.
Monitoring PO Progress, continued

PO Query Activity

The following is an activity to search for a PO using PO Query:

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Search</td>
<td>Item description</td>
</tr>
<tr>
<td>2 Operation</td>
<td>Begins with</td>
</tr>
<tr>
<td>3 Compare to</td>
<td>LIDO</td>
</tr>
</tbody>
</table>

The system finds any PO that contains an item that begins with LIDO.

All options that match your search criteria display at the bottom of the window.

Hint: Click a column header to sort the information in ascending or descending order.
Monitoring PO Progress, \textit{continued}

\textbf{PO statuses}

The following table identifies purchase order statuses:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Order</td>
<td>PO has been submitted to the vendor.</td>
</tr>
<tr>
<td>Complete</td>
<td>PO has been completely received.</td>
</tr>
<tr>
<td>Partial</td>
<td>PO has been partially received.</td>
</tr>
<tr>
<td>Draft</td>
<td>PO has been saved but not submitted to the vendor.</td>
</tr>
<tr>
<td>Canceled</td>
<td>The entire PO has been canceled.</td>
</tr>
<tr>
<td>BO Draft</td>
<td>Blanket Order that has been saved as a draft. It cannot be released against.</td>
</tr>
<tr>
<td>BO Template</td>
<td>Blanket Order that is ready to be released against.</td>
</tr>
</tbody>
</table>

\textbf{PO Line statuses}

The following table identifies PO line statuses:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Order</td>
<td>Line has been submitted to the vendor.</td>
</tr>
<tr>
<td>Killed</td>
<td>Line was submitted yet canceled order of the line.</td>
</tr>
<tr>
<td>Complete</td>
<td>Line received in full.</td>
</tr>
<tr>
<td>Draft</td>
<td>Line has not been submitted yet.</td>
</tr>
</tbody>
</table>
Monitoring PO Progress, continued

Review the PO Cover Sheet

The Cover Sheet automatically displays when you open a purchase order and the Display Cover Sheet box is checked as noted below:

Click **OK** to close the window.

**Hints:** To reopen the Cover Sheet window, select **Cover Sheet** from the Information menu or click 📝.
Monitoring PO Progress, continued

Search for an item

Click the Go To button and the Go To window displays.
Select the drop-down list and pick a Where field option. Enter the Begins with Value. 
Click Go to.

Result: The line item highlights.

Print a purchasing order

Click the printer icon to print a copy of the purchase order.
Monitoring PO Progress, continued

View Vendor Information

To view information about the vendor, select Vendor Information from the Information heading or click the Vendor Information icon.

Result: The Vendor Information window displays.

Submit Types

The table below describes the vendor submit types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDI</td>
<td>PO is sent to the EDI server to be transmitted to the vendor.</td>
</tr>
<tr>
<td>Fax</td>
<td>PO is sent to the Fax server to be faxed to the vendor.</td>
</tr>
<tr>
<td>Phone</td>
<td>PO is saved in the system, buyer calls in the order.</td>
</tr>
<tr>
<td>Mail</td>
<td>PO automatically prints.</td>
</tr>
<tr>
<td>Supply Source</td>
<td>Send PO electronically via internet to a HSS vendor.</td>
</tr>
</tbody>
</table>
Monitoring PO Progress, continued

PO Viewer

You can use the PO Viewer application to review purchase order activity and expedite purchase orders that have been on order or partially filled for a long time.

To access PO Viewer, open the PO Viewer application.

Result: The POView window displays.

Select Filter and click Filter Criteria.

Result: The Filter Criteria window displays.

Enter filter criteria, then click OK.

Result: The POView window displays with the matching criteria.
Purchase Order History

Introduction

Once changes have been made to a PO and it has been resubmitted, the PO History is written. You may also view the PO History in Receiving and Invoice Matching.

Steps

To view PO History:

1. Open a PO through PO Query, select Information, then click PO History.

2. To see further information, select the line, then click View.
Vendor Editor

Introduction

The Vendor Editor contains a list of purchasing vendors. To access Vendors, open Editors, select Vendor from the menu, then click Vendor.

Result: The Vendor List tab displays.

The following table describes the Vendor Editor tabs and buttons:

<table>
<thead>
<tr>
<th>Tab/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Click New to create a vendor. Not applicable for audience.</td>
</tr>
<tr>
<td>Remove</td>
<td>Highlight a vendor from the Vendor List and click Remove to inactive a vendor. Not applicable for audience.</td>
</tr>
<tr>
<td>Vendor Group</td>
<td>Click Vendor Group to create a vendor grouping and assign vendors to the group. Useful for reporting purposes. Future feature for University of Rochester.</td>
</tr>
<tr>
<td>Vendor List</td>
<td>Listing of purchasing vendors in the table.</td>
</tr>
<tr>
<td>Information</td>
<td>General information about the vendor. Designate submit type.</td>
</tr>
<tr>
<td>Address Detail</td>
<td>Enter address information for the vendor.</td>
</tr>
<tr>
<td>Remittance Vendor</td>
<td>Assign vendor to a remittance vendor.</td>
</tr>
<tr>
<td>Ship To</td>
<td>Associate Ship To Locations, tax information, enter Supply Source data, and enter fax numbers for Ship To.</td>
</tr>
<tr>
<td>EDI Specifications</td>
<td>Enter EDI data for vendor.</td>
</tr>
<tr>
<td>Notes</td>
<td>User defined text field to enter reference information about the vendor. Able to view in Purchasing.</td>
</tr>
</tbody>
</table>
Query a Vendor

Steps to query a vendor

Follow the steps below to query a vendor:

1. From the Vendor List tab, select the vendor, then go to the Information tab.

   **Result:** The Information tab displays.

   ![Vendor Editor - [Vendor: [OWNERS AND MINOR - OW200]]](image)

   - **Vendor Name:** [OWNERS AND MINOR - OW200]
   - **Code:** Ow200
   - **Submit Type:** EDI
   - **Max # of PO Lines:** 20
   - **Level Days:** 5

2. Review Vendor Name, Code, and Submit Type. Note: The Vendor Code is unique.

   Vendors should be added per the University of Rochester Corporate Purchasing Vendor File Policy.
Query a Vendor, continued

Address Detail tab

3 View the Vendor Contact address on the Address Detail tab.

Note: To view sales contact or service contact information, select the contact type from the drop down list.

Purchasing will be responsible for creating and maintaining Purchasing Vendors.

Accounts Payable will create/maintain the Remittance Vendors.
Query a Vendor, continued

Ship To tab

4 View ship to location(s) from the Available Ship To Locations list.

Note: Receiving at Strong Memorial Hospital and Highland Hospital will always be associated with the vendor.

![Vendor Editor - [Vendor : OWRIS AND MINOR - OWEND1]](image)

Note: The Customer No field can be used to store the customer number used by the vendor to identify the ship-to location.

Notes tab

5 View user defined text information on the Notes tab to track changes in vendor information such as name and address changes. The notes display in Purchasing, Bids, Contracts, and Rebates.
Item Manager

Notes: The Customer No field can be used to store the customer number used by the vendor to identify the ship-to location.

Introduction

The Item Manager contains information on all items that are cataloged at your facility. To access the Item Manager, open Editors, select General from the menu, then click Item or click the Item Manager icon.

Result: The Item Search Criteria window displays.
Query items

To search for an item, follow these steps:

1. Open **Item Manager**.

2. Enter search criteria into the appropriate fields, then click **OK**.

   Hint: Use (%) to search on partial words. Narrow your results by filtering by status.

   **Result**: The Items results window displays.

The Item File Policy and Procedure is located on the Purchasing Intranet web page.
Item Manager, continued

Query item activity

Items with pending changes are listed twice on the Select tab. Once as Active and once as Pending. The Active item is view only until the changes are implemented. The Pending item can be changed at any time.

To view an item’s activity, from the Select tab click Activity.
Query an Item

Query Item Tabs

Follow the steps below to review item information:

1. After selecting your item, view the Info tab to review item information.

If the item has alternative descriptions, go to the Description tab to view the alternative descriptions.

2. At least one Corporation and a primary Vendor per Corporation display on the Vendors tab.
Query an Item, continued

Packaging tab

3 Packaging information can be viewed on the Packaging tab.

Packaging is built using the following steps:

Step 1) Enter the smallest UOM in the UM field.

Step 2) Fill in the price, Vendor Catalog Number, and UPN number.

Step 3) Turn on Auto Price Calculation (optional).

Step 4) Click **Insert Before** to enter next the UOM. Repeat steps for each UOM.

Note: Only Purchasing will enter Packaging Information.
Query an Item, continued

Packaging Changes

There are several options available when applying item changes:

a Only to one corporation

b All system selected corporations that are highlighted

c Only corporations the user selects.

Considerations:

• The primary vendor must have at least one packaging option.
• Packaging changes can be made for one corporation or any other corporation that has that item/vendor combination.
• If the item is stocked in a Supply Location, the Location Conversion Wizard displays.
• Packaging changes can be scheduled for a future date.
Query an Item, continued

**Item Accounts tab**

4 Each item has a default expense code per Corporation on the Item Accounts tab.

```
<table>
<thead>
<tr>
<th>Corporation</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>E9 (UNIVERSITY OF ROCHESTER)</td>
<td></td>
</tr>
</tbody>
</table>
```

4 Each item has a default expense code per Corporation on the Item Accounts tab.

## Misc tab

5 The Misc tab contains user defined information and data used with Horizon Surgical Manager.

Note: When SMH and HH items were combined, the Misc 1 field was used to store the old HH number.

See the guidelines in the Item File Policy posted on the Purchasing Intranet web page.
Chapter 4 - Receiving
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:
- create a receipt for a specific PO
- receive items by exception
- receive overshipments
- kill and unkill partially received PO lines
- return items for replacement or vendor credit
- receive items in different units of measure
- view Receipt History and Purchase Order Activity.
Receiving Process

Overview
The following diagram illustrates the general receiving process:

Questions
Answer the following questions based on your facility:
• Do you allow receivers to Receive in Full? Most times yet Strong OR does not
• Do you allow receivers to receive overshipments? YES
• Do you allow receivers to do returns? YES
• Do you allow receivers to kill PO lines? YES
• Do you allow your receivers to receive in alternate units of measure? YES
• Do you perform blind receiving? NO

Policy & Procedure
Each online department will be responsible for receiving their own orders. Offline departments will send 312 requisitions to Corporate Purchasing. Those orders will be received using the Auto Receive functionality in Purchasing. We will also be using 856 electronic receiving for some vendors (i.e. Owens and Minor).
Receiving Process, continued

Steps

The following are the major steps to complete the receiving process.

1. Open a Purchase Order through the Receiving application.
2. Verify and edit receive quantities.
3. Save the receipt.
4. Deliver the items using the Delivery Document(s).
Step 1: Open a Purchase Order

Enter or search for a Purchase Order number

1. Enter the Vendor’s Packing Slip number, if applicable.
2. Check the Receive in Full flag, if applicable. Note: Reference the next page for more information about Receive in Full.
3. Enter the PO Number. Note: To locate an unknown PO Number, click to search. The Find PO window displays. Enter text in the fields and click Search. Double-click on your desired PO. The Receiving window displays and step 4 is not applicable.
4. Click OK.

Result: The Receiving window displays.

Purchase Order Status Types

The Purchase Order Statuses change based upon the receiving functions that have been applied to the PO. The table below describes the status types:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Order</td>
<td>ordered, not received</td>
</tr>
<tr>
<td>Partial</td>
<td>partially received</td>
</tr>
<tr>
<td>Complete</td>
<td>all received</td>
</tr>
<tr>
<td>Killed</td>
<td>PO has been killed by purchasing or receiving</td>
</tr>
</tbody>
</table>
Receive in Full

Introduction

Receive in full is an optional receiving feature that defaults the open PO quantity into the quantity field of the receipt.

Select or deselect locations

Receiving in full can be selected or deselected in two locations:

1. Open a Purchase Order window.
   Check the Receive in Full box. Note: The checked box becomes the default display.

2. Receiving button toolbar.
   Click the Receive in Full icon.
Step 2: Verify and Edit Receive Quantities

Receiving window

After selecting a purchase order, the Receiving window displays.

You may access more information about the receipt and/or line by using the menus or clicking on the toolbar icons. See detailed information about these features on the next pages.
Step 2: Verify and Edit Receive Quantities, continued

Receiving window toolbar icons

The following table describes the Receiving window toolbar icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎼</td>
<td>Receive in full - security dependent feature</td>
</tr>
<tr>
<td>📂</td>
<td>line receiving note</td>
</tr>
<tr>
<td>📄</td>
<td>line info - PO#, item detail, pkg - view only</td>
</tr>
<tr>
<td>🗑</td>
<td>Kill or “unkill” item - may need to do if item is backordered and decide to order from another vendor</td>
</tr>
</tbody>
</table>

Information menu

The following features are accessed from the Information menu:

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover Sheet</td>
<td>View PO#, Packing Slip #, PO date, and delivery location.</td>
</tr>
<tr>
<td>Vendor</td>
<td>View name, address, and sales representative.</td>
</tr>
</tbody>
</table>
Step 2: Verify and Edit Receive Quantities, continued

Item Information Window

The Item Information window provides specific information about the item.

![Image of Item Information window]

The following table describes the Item Information window tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Line</td>
<td>Displays information from the Purchase Order Line.</td>
</tr>
<tr>
<td>Item Detail</td>
<td>Displays information about the item in Item Manager.</td>
</tr>
<tr>
<td>Packaging</td>
<td>Displays the item’s packaging as reflected on the Item Manager, Packaging tab.</td>
</tr>
</tbody>
</table>

✍
Step 3: Save the Receipt

Saving the Receipt

To save the receipt, click .

Result: The Receiving window displays. After receiving against a purchase order and selecting **Save**, the Save Receipt window displays.

The following table is a description of the buttons and boxes on the Receiving window:

<table>
<thead>
<tr>
<th>Button/Box</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Save</td>
</tr>
<tr>
<td>No</td>
<td>Don’t Save</td>
</tr>
<tr>
<td>Cancel</td>
<td>Go back to Receipt</td>
</tr>
<tr>
<td>Help</td>
<td>Access to Online Help</td>
</tr>
<tr>
<td>Print Delivery Documents</td>
<td>When saving the receipt, you can select or deselect this box. If you select this box, the delivery document prints automatically.</td>
</tr>
<tr>
<td>Number of Copies</td>
<td>You may also choose the quantity of delivery documents you wish to print.</td>
</tr>
</tbody>
</table>
Step 4: Deliver the Items

Introduction

Deliver the items using the Delivery Document(s).

Note: The delivery document has a signature line so that a department can sign the form when delivery is made.

Delivery documents print based on the delivery location from the purchase order line. It only prints the PO lines that have been received.

Delivery documents can be filed with the packing slip or separately.

UR/SMH Receiving will not be entering receipts. Therefore, they will not be using the PMM Delivery Document. They currently have a 3 part form that is used for delivery of products.

The 3 part form is called a Delivery Ticket.
1. 3rd copy stays with Receiving before deliver and is filed.
2. 2nd copy is customer copy.
3. Top copy is signed and returned to Receiving and filed (separately from 3rd copy).
Processing Overshipments

Introduction

When the vendor sends you more items than you ordered, you will record this as an overshipment.

When you enter a received quantity that is higher than the PO quantity, the Reason for Adjustment window automatically displays.

Reason for Adjustment

Select a Reason for Adjustment.

Leave a Receiving (Line) Note for the AP department.

Hints:

- is a table that is built in the Codes Editor
- can only be viewed in Receipt History.

If the department is willing to accept the overshipment, they can receive it in the system. If they are not willing to accept it, they should receive it and return it.

Use Reason For Adjustment code: OVR - Overshipment.
Entering Line Notes

Introduction

Receiving (Line) Notes icon.

The Receiving Notes window displays any notes attached to the selected line item. This window opens when you click the Line menu and select Notes.

The Receiving Department should leave a Receiving Note for Accounts Payable to communicate any irregularities. Leave a Receiving Note in the following incidences:

- Overshipments
- Killed Lines
- Unkilled Lines
- Returns

It is recommended to initial and date the note.

For staff who are receiving in products: Enter a line note for the item noting any receiving issues (i.e. overshipment, wrong product shipped, item returned) and include your initials and date of the note.

If the vendor ships a product that is not on the requisitioner's order, he will not be able to receive it in. In order to receive it (and possibly return it), a request will need to be made to Corporate Purchasing (Website - PMM section) to request the item be added.
Killing / Unkilling Partial PO Lines

Introduction

Purchase order lines can be killed and unkill within the Receiving application (if the option is given to the receiving staff by the System Administrator).

**Important:** You can *not* kill a line that has been received in full.

There are several ways to kill or unkill lines:

- From the menu bar, click **Line**, then **Kill**.
- Right-click the line to be killed, then click **Kill**.
- Use the Eraser icon in the toolbar.
Entering Returns for Vendor Replacement

Introduction

When you need to return an item to the vendor, enter a negative quantity for the line item in the receiving window.

**Important:**

When returning an item, leave a Receiving Note for AP.

Steps to enter a return for vendor replacement

1. On the line to be returned, enter:
   - a negative quantity and
   - reason for adjustment.
2. Enter a Receiving Note for the line item.
3. Save the receipt.

**Result:** The quantity for the item is now open. Therefore, when the replacement shipment arrives, it can be received into the system.
Entering Returns for Vendor Credit

Introduction

If you need to return an item to the vendor, enter a negative quantity for the line item in the receiving window.

**Important:** When returning an item, leave a Receiving Note for AP.

Steps to enter a return for vendor credit

1. On the line to be returned, enter:
   - a negative quantity and
   - reason for adjustment.
2. Enter a Receiving Note for the line item.
3. Save the receipt.
   - **Result:** The quantity for the item is now open.
4. Open the receipt again.
5. Kill the line.
6. Save the receipt again.
   - **Result:** The quantity is closed.
Receiving in Alternate Units of Measure

Introduction

Receivers can receive in a different unit of measure than what was on the Purchase Order, if they have the proper security. When receiving Catalog items, the receiver can choose from any valid unit of measure for that item. The system determines if the entered quantity constitutes a full or partial receipt and updates the PO accordingly.

When receiving Non-Catalog items, the receiver can choose from any valid unit of measure built in the Codes Editor. An email notification is sent to the buyer notifying him of the change.

Receive in alternate unit of measure for Catalog item

To receive a Catalog item in an alternate UM, follow these steps:

1. Change the UM for the item to the UM that was received.

2. Enter the quantity received.

   Leave a line note for AP.

Some vendors have shipped products in a different unit of measure than the order unit of measure. As long as the receipt unit of measure is in the item packaging table, users should be able to receive the product in that unit of measure.
Receiving in Alternative Units of Measure, continued

Receive in alternate unit of measure for Non-Catalog item

To receive a Non-Catalog item in an alternate UM, follow these steps:

1. Change the UM for the item to the UM that was received.

2. Enter the quantity received.

3. Leave a line note for AP.

Important:

If a Receiver receives a Non-Catalog item in a different unit of measure than was on the original PO, the system automatically sends an email to the Buyer notifying him that there is a Receiving Discrepancy that needs to be resolved, if the appropriate security flags are set.

Since a receiver will not know if the email notification was sent, a line note needs to be added for non-file items indicating that an item was received in an alternate unit of measure. The buyer will need to fix the problem in the Purchasing application.

The buyer finds the PO through Purchasing Query, goes to the Line menu, selects Receiving Discrepancy and resolves the problem.
View Receipt History

Introduction

The Receipt History window contains an audit trail of line transactions.

To view Receipt History, either click the Receipt History icon or select History from the Line menu.

Within the Receipt History window, any previously received quantity for the selected line item displays.

If the line was received in an Alternate UM, the factor is visible in Receipt History.
View Purchase Order Activity

Introduction

Receivers can view information about Purchase Orders that were resubmitted. From the Information menu, select PO History.

Result: PO Activity window displays.

To review the activity in more detail, highlight the line, then click View. When finished click OK and close the window.
Chapter 5 - Resolve Invoice Discrepancies
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:

- resolve invoice discrepancies.
Resolving Invoice Discrepancies

Discrepancy Flow

When differences exist between the vendor invoice and the purchasing and receiving system generated documents, AP may electronically route discrepancies to the buyer for resolution.

- AP determines if there is a discrepancy, then saves it as Discrepant.
- Purchasing or end user department investigates price (purchasing - item master item; department - non-catalog item).
- End user department investigates quantity or missing receipts.
- Purchasing or end user department resolved the problem, communicates resolution, then approves the invoice.

Notes: Not all users attending this class will be required to resolve invoice discrepancies. Some departments such as the OR and Pharmacy have specified staff that work through all discrepant invoices.
Resolving Invoice Discrepancies, *continued*

**Steps to resolve the problem**

These are the steps to resolve a problem:

1. Assess the problem using these methods:
   
   a. Identify discrepant lines (the discrepant lines display in red).
   
   b. Obtain more information about the line by reviewing the line note(s).
   
   c. Verify receiving information with the receiver.
   
   d. Review the PO and item information.
   
   e. Utilize off line investigations methods, such as, calling the vendor to verify the price.

2. Enter the necessary change(s) by clicking the appropriate button.

3. Enter a Resolution Code and Resolution Note to communicate your message.

4. Save the invoice as **Approved**.

---

Communication method with Accounts Payable:

Resolution notes need to be included along with the Resolution code. The note should include your initials and date.
Assess the Problem

Introduction

To start your research, double-click the discrepant line.

Result: The Line Detail window displays.

The following two tabs are important to Buyers:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price/Quantity</td>
<td>Review price and quantity information. The price and quantity detail displays PO and invoice data. The Discrepancy Code, if used, identifies the type of problem. The Resolution Code is entered by the buyer to flag the type of resolution.</td>
</tr>
<tr>
<td>Note</td>
<td>Review the Discrepancy Note entered by AP. Buyer utilizes the Resolution Note to communicate resolution.</td>
</tr>
</tbody>
</table>

Hint: From the Invoice Matching toolbar, click (Open PO button) to drill back to the purchase order.
Assess the Problem, continued

Line Notes

Continue your research by checking Line Notes.

Notes: If any notes are available, a tack icon displays next to the line in the Invoice Discrepancy window.

Follow these steps for line notes:

1 You may view Discrepancy, Invoice, PO, and Receiving notes from the Detail Line Notes window.

2 Enter a note to describe the discrepancy resolution in the Resolution Note section. Remember to include your initials and date.

3 Click Close when finished.

Hints: To keep the Detail Line window displayed as you move from line to line, click (tack button).
Assess the Problem, continued

View invoice information

The Open PO Invoice displays the User Info as to who is the PO Composer, who created the invoice, and who is assigned to the discrepant invoice. To view the Invoice Information window, go to the **Info** menu, then click **Invoice**.

Result: The Open PO Invoice window displays.

![Invoice Information Window](image)

View routing notes

To view routing notes, go to the **Info** menu, click **Notes**, then select **Routing** as the note type. Result: The Routing Note displays.

![Routing Note](image)
Resolve the Problem

Resolving the problem

Follow the steps below to resolve a price discrepancy for the line:

1. Click Invoice Price or PO Price on the Price/Quantity tab. Note: Item Master price discrepancies should be resolved and approved by Corporate Purchasing.

Result: The amount from the selected button displays in the Approve Price box.

2. Select a resolution code outlining the resolution to the AP staff.

3. Leave a Resolution Note on the Notes tab. Include the date and your initials.

Note: Enter both a Resolution Code and Resolution Note.
Approve the Invoice

Save As options
After resolving the problem, it is time to save the invoice and route it back to AP.

1. Click the Save As button.

Result: The Save As window displays.

2. Click **Approved**, then click **OK**.

There are several Save As options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discrepant</td>
<td>Defaults routing to the PO Composer. Allows buyers to route the invoice to another user for resolution.</td>
</tr>
<tr>
<td>Draft</td>
<td>Sends the invoice back to the Buyer’s Discrepant tab.</td>
</tr>
<tr>
<td>Approved</td>
<td>Sends the invoice to Accounts Payable. No longer on the Buyer’s Discrepant tab.</td>
</tr>
</tbody>
</table>
Routing Discrepant Invoices

Overview

The Invoice Discrepancy Routing feature allows the user to route a discrepant invoice to another user to resolve the discrepancy. The user is able to select the appropriate ID from the drop-down list. The invoice is then routed to that user’s Invoice Matching Discrepancy tab for resolution. A routing note can be added to the invoice and an email notification can be sent automatically to the user with a link to the discrepant invoice.

Steps

To route an invoice to another user, follow these steps:

1. Save the Invoice as Discrepant.
2. Check the Send Email Message box to send an email notification (optional).
3. Select the user to receive the discrepant invoice from the drop down list.
4. Add a routing note (optional). Routing Notes are included in the email message and added to the Invoice Notes dialog box.
5. Click OK.
Chapter 6 - Generating Reports
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:

- print a standard report
- sort data and enter extract values
- export reports.
Generating a Receiving Report

Introduction
Pathways Materials Management software includes many Standard Reports. These reports can be printed, exported, and saved.
Generating a Receiving Report, *continued*

**Running a report**

Follow the steps below to generate a report:

1. Log into **Pathways Reports**.

   **Important:** You must log into Pathways Reports even if you have another PMM application open.
   The Reports Login is case sensitive. You must turn *off* the Caps Lock before logging into Reports.

2. Select a folder.

3. Double-click the report you wish to run.

   **Hints:** If there’s a padlock icon next to a report, you do not have security rights to run it.

4. Set your Extract values and Sort method. See next pages for more details.

5. Click **Run Reports**.

   **Result:** The report displays in view mode. Click the Printer icon to print a hard copy.
Selecting Extract Values

Introduction

Once you have decided which report you are going to run, you have the option to filter the information presented on the report.

Step detail can be found on the next page.
Selecting Extract Values, continued

Steps

Follow these steps to set and save extracts:

1. Select the database to run the report against. Note: In most cases, the database string will be preset for you.
2. Select the extract(s) that you want to use.
3. Choose an operator. For example, “Begins With” or “=”.
4. Type in the data to filter by or search for the exact information, then click Search.
5. Repeat Steps 1 through 4 as necessary.
6. To preset and save the extracts so that you can use them again, click the Save icon.
7. Enter a report description name.
8. To use the preset extract report at a later time, open the report by double clicking on it.
9. Click Open.

Result: A listing of all saved extracts for that report display.

10. Select the set of extracts you would like to use.

**Important:** If an extract row is shaded in yellow, that information is required to run the report.
Selecting Sort Options

Defining the sort order

Use the Sort options to define the order of the information on the report.
Selecting Sort Options, continued

Steps

Follow the steps below to sort report information:

1. Click the box to the left of the fields by which you want to sort.
   
   **Result:** At the top of the Reports window, the up and down arrows are activated.

   **Hints:** You can select an Ascending or Descending order for each row. To change the sort sequence, select the row.

2. Use the up or down arrow to change the sort sequence.
Report View

Introduction

When you have selected all the extract and sort options for the report, click **Run Report**.

Result: The Preview window displays.

Hints:

- Use the Preview Pane section to quickly find locate a record.
- Use the page buttons to move forward and backwards through the report.
Exporting Results

Introduction

Within Pathways Reports, you have the ability to export Report results into a variety of formats.

1. To export a report, click the export button.

2. Select the format you want to export the report into.

3. Select the destination for the export.

4. Click OK.

Result: The report is saved as the selected format to the destination drive.
Chapter 7 - Purchasing
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:

- create and edit purchase order with Catalog and Non-Catalog items
- change item pricing on a purchase order
- add line notes
- pull items from PMM Requisitioning on to a purchase order
- print a purchase order
- resubmit a purchase order
- allocate a PO line to multiple cost centers
Creating Purchase Orders

Introduction

The Purchasing application is used to create, edit, and submit purchase orders, review PO activity, and cancel POs that have no receipt activity.

To access the Purchasing application, double-click the Purchasing icon.

Result: The Purchase Order Selection Window displays.

Create a Purchase Order

Follow the steps below to create a purchase order:

1. Open Purchasing.
2. From the Purchase Orders tab, double-click New Purchase Order.
3. Assign a Vendor and Corporation.
4. Review the PO Cover Sheet.
5. Enter items and item information.
6. Submit the PO or save it as a draft.
Creating Purchase Orders, *continued*

**Step 3 - Assign a vendor and corporation to a purchase order**

In order to create a new PO, you must select a vendor and corporation. Follow the steps below to assign a vendor and corporation:

1. Double-click **New Purchase Order**.

Result: The Assign a Vendor window displays.

- Enter either the Vendor Name or the Vendor Code.

**Hints:**

- If you do not know the vendor’s full name, use the Search button to find a vendor by name.
- In a multiple corporation facility, you can use the Search button to select a different corporation depending upon your security rights.
- University of Rochester/Strong Memorial Hospital is Corporation 09.
- Highland Hospital is Corporation 01.

**Important:**

- All searches in Pathways Materials Management are case-sensitive, CAPS must be on.

2. Click **OK** when done.
Creating Purchase Orders, continued

Step 4 - Review the PO Cover Sheet

The Cover Sheet automatically displays when the Display Cover Sheet box is checked as noted below:

Verify the fields of information and make changes as needed. Note: You may need to change the Delivery Date, Classification, and Ship To information.

Click OK when done.

Hints: To reopen the Cover Sheet window, select Cover Sheet from the Information menu or click .
Creating Purchase Orders, *continued*

**Cover Sheet fields**

The table below describes the key Cover Sheet fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporation</td>
<td>Primary corporation for the purchase order. Defaults as corporation for each item unless changed.</td>
</tr>
<tr>
<td>Number</td>
<td>Unique purchase order number that is system assigned. Prefixes and suffixes pull from the Corporation Editor or User Profile. POs submitted via EDI are limited to a maximum of 12 characters.</td>
</tr>
<tr>
<td>Date</td>
<td>Defaults to today’s date. Type new dates or use the calendar button to change the date.</td>
</tr>
<tr>
<td>Delivery Date</td>
<td>Anticipated delivery date. It defaults to today’s date plus the lead time entered in the Vendor Editor.</td>
</tr>
<tr>
<td>Classification</td>
<td>Code your organization uses to categorize purchases. It defaults from the user’s profile.</td>
</tr>
<tr>
<td>Default Project</td>
<td>Assign a Project and Sub-Project to the Purchase Order. For Highland Hospital use only.</td>
</tr>
<tr>
<td>Confirmed?</td>
<td>Indicator used to track EDI 855 vendor confirmed PO. You can manually check the box if confirmation is received verbally. To look for the electronic confirmation, click <strong>Confirmation</strong> from the <strong>Information</strong> menu.</td>
</tr>
<tr>
<td>Composed by</td>
<td>PO creator.</td>
</tr>
<tr>
<td>Phone</td>
<td>Phone number defaulting from User’s record.</td>
</tr>
<tr>
<td>Status</td>
<td>Current status of purchase order.</td>
</tr>
<tr>
<td>Ship To</td>
<td>Location the ordered items are shipped. Note: Orders to be shipped to Strong Hospital or Highland Hospital will generally default to the Receiving Ship To location. The internal department will be listed as the Deliver To location.</td>
</tr>
<tr>
<td>Bill To</td>
<td>Location the ordered items are billed.</td>
</tr>
<tr>
<td>Discount %</td>
<td>Overall discount percentage to be deducted from each line of the PO.</td>
</tr>
<tr>
<td>RGA Number</td>
<td>Return Goods Authorization Number.</td>
</tr>
</tbody>
</table>
Creating Purchase Orders, continued

Comments section

The lower portion of the Cover Sheet is the Comments section. It is where notes about the PO, Purchasing Vendor, Remit Vendor and general comments display.

You may enter up to 500 characters in the comment field.

- PO Comments print on the PO. You can type in the comment or attach a Standard Note. It will contain the Requested by section of the 312 requisition that is currently entered in the NOVA RECV Note field for Purchasing staff.
- Remit Vendor Comments are for internal view only. They pull from the Remittance Vendor Editor.
- Boilerplate Comments are attached to a Corporation/Classification combination. The comments are built in the Corp/GL Editor.

Standard Notes

Standard notes are pre-defined comments that are added to the PO Comments or PO line.

1. To insert a Standard note on a PO, click Standard Notes.

Result: The Standard Notes window displays.

2. Enter a Standard Note Name, then click Find.

3. Select the note, then click Insert on PO.

Hint: Your Standard notes/comments used in NOVA have been built into PMM.
* To create a Standard note, click Add, enter an unique Name and text, then click OK.
* To edit a Standard note, search for the note, click Edit, make changes, then click OK.
* To remove a Standard note, search for the note, then click Remove.
Creating Purchase Orders, *continued*

**Step 5 - Enter items and item information**

From the Purchase Order window you can perform various tasks by clicking the appropriate button on the Purchasing toolbar. The tasks can also be accessed through the menu bar. Some of the key buttons are displayed below:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| ![Open Folder](image1.png) | Open Folder  
Menu option: File>Open |
| ![Save](image2.png) | Save  
Menu option: File>Save |
| ![Submit](image3.png) | Submit  
Menu option: File>Submit |
| ![Print](image4.png) | Print  
Menu option: File>Print |
| ![Line Notes](image5.png) | Line Notes  
Menu option: Line>Line Notes |
| ![Item Search](image6.png) | Item Search  
Menu option: Line>Search |
| ![Cover Sheet](image7.png) | Cover Sheet  
Menu option: Information>Cover Sheet |
| ![Vendor Information](image8.png) | Vendor Information  
Menu option: Information>Vendor Information  
Hint: This is where you can change the PO submit type. |

**INSTRUCTOR NOTES:**

Review buttons. Point out buttons on RJob Aid.

Point out that a PO can have multiple Delivery Locations. Show how to search for an item. Point out the wildcard (%). Ref the RJob Aid.
Creating Purchase Orders, continued

Purchasing Window

The Purchasing window contains data entry columns.

The columns are described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Purchase Order line number.</td>
</tr>
<tr>
<td>A</td>
<td>Line allocation flag. Item is allocated to more than 1 cost center.</td>
</tr>
<tr>
<td>Item number</td>
<td>The Cataloged item number from the Item Manager.</td>
</tr>
<tr>
<td>Description</td>
<td>Item’s description.</td>
</tr>
<tr>
<td>Req No</td>
<td>Enter the requisition number. Note: If you use PO Wizard, a requisition number displays when you pull the item on to a PO.</td>
</tr>
<tr>
<td>Vendor Ctlg</td>
<td>Vendor Catalog Number.</td>
</tr>
<tr>
<td>Qty and UM</td>
<td>Enter the quantity to order. Unit of Measure defaults from I/M.</td>
</tr>
<tr>
<td>Price</td>
<td>Price defaults from I/M. Contract price defaults if available.</td>
</tr>
<tr>
<td>Exempt/Tax Amt</td>
<td>If an item is not taxable, the Exempt field contains a check mark. Note: UR and HH are tax exempt.</td>
</tr>
<tr>
<td>Ext Price</td>
<td>Quantity multiplied by Price.</td>
</tr>
<tr>
<td>Delivery Loc</td>
<td>Deliver to location for the item.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost center to charge for the item. (You know as Account number)</td>
</tr>
</tbody>
</table>

Step 6 - Submit or Save Purchase Order

When all items are entered, click Save to save PO as a Draft or click Submit to send.
Entering Catalog Items

If you know the item number, then...

1. Enter the item number in the Item field.
   
   Result: The Description, Vendor Catalog Number, Unit of Measure, and price default from the Item Manager.

2. Enter the Qty (quantity), Delivery Location (deliver to), and Cost Center (which you know as the Account Number).

   
   Hints: Remember to enter the Delivery Location and Cost Center for the first PO line. The information defaults for the next line. Change the information when appropriate.

If you do not know the item number, then...

1. Select Search from the Line menu, or click the Binoculars button.

2. Select Description in the Where field.

3. Enter part of the Item description in the Begins with Value field.
   
   Result: The Description, Vendor Catalog Number, Unit of Measure, and price default from the Item Manager.

4. Enter the Qty (quantity), Delivery Location (deliver to), and Cost Center.

Delete lines

To remove a line from a purchase order before it is submitted, right-click on the line and select Delete.
Entering Catalog Items, continued

Price changes

The ability to make price changes on a PO is based on your security rights. Price changes can be:

• Temporary - changes the price on this PO only, or
• Permanent - changes the price on this PO and updates the Item Manager (and contract if the item is on a contract).

When you enter a different price on the line, the Purchasing price window displays.

![Purchasing price window]

Select Purchase Order Only, then click OK.

Result: The updated price displays on the purchase order.

**Important:** If the item is on a Contract, the ability to change a price is based not only on your security rights, but also on the Contract rules.
Line Detail

Double-click the line to display the Line Detail window.

The upper portion of the screen contains the base line information about the item. On the Line Detail window, you can enter information specific to a line.

Note: To expand the drop down box view, right-click on the drop down box.

There are several tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Line</td>
<td>View PO line information such as item, vendor and manufacturer information.</td>
</tr>
<tr>
<td>Packaging</td>
<td>View item packaging as defined in the Item Manager.</td>
</tr>
<tr>
<td>Item Tax</td>
<td>View tax jurisdictions. Not applicable for customer.</td>
</tr>
<tr>
<td>Supply Tracking Info</td>
<td>Enter information used with Supply Tracking application. Not applicable for customer.</td>
</tr>
<tr>
<td>Line Allocation</td>
<td>Distribute charge to multiple cost centers for an item based on percentage or dollars.</td>
</tr>
<tr>
<td>Components</td>
<td>Enter parts for a Non-Catalog item i.e. computer monitor, CPU, keyboard, etc.</td>
</tr>
</tbody>
</table>
**Entering Catalog Items, continued**

**Line Notes**

To attach a PO Line Note, go to the Line menu, then click **Line Notes**.

**Result:** The Line Notes window displays.

![Line Notes Window](image)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Function</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Line</td>
<td>View only</td>
<td></td>
<td>X_</td>
</tr>
<tr>
<td></td>
<td>Displays in Receiving</td>
<td>___</td>
<td>X_</td>
</tr>
<tr>
<td></td>
<td>Displays in AP</td>
<td>X_</td>
<td>___</td>
</tr>
<tr>
<td></td>
<td>Prints on the PO</td>
<td>X_</td>
<td>___</td>
</tr>
<tr>
<td>Requisition Notes</td>
<td>View only</td>
<td>X_</td>
<td>___</td>
</tr>
<tr>
<td></td>
<td>Displays in Receiving</td>
<td>___</td>
<td>X_</td>
</tr>
<tr>
<td></td>
<td>Displays in AP</td>
<td>___</td>
<td>X_</td>
</tr>
<tr>
<td></td>
<td>Prints on the PO</td>
<td>___</td>
<td>X_</td>
</tr>
<tr>
<td>Requisition Cover</td>
<td>View only</td>
<td>X_</td>
<td>___</td>
</tr>
<tr>
<td></td>
<td>Displays in Receiving</td>
<td>___</td>
<td>X_</td>
</tr>
<tr>
<td></td>
<td>Displays in AP</td>
<td>___</td>
<td>X_</td>
</tr>
<tr>
<td></td>
<td>Prints on the PO</td>
<td>___</td>
<td>X_</td>
</tr>
<tr>
<td>Receiving</td>
<td>View only</td>
<td></td>
<td>X_</td>
</tr>
<tr>
<td></td>
<td>Displays in Receiving</td>
<td>X_</td>
<td>___</td>
</tr>
<tr>
<td></td>
<td>Displays in AP</td>
<td>X_</td>
<td>___</td>
</tr>
<tr>
<td></td>
<td>Prints on the PO</td>
<td>___</td>
<td>X_</td>
</tr>
</tbody>
</table>

Note: Case Notes come from stockless case carts or Horizon Surgical Manager cases. They are view only notes. University of Rochester is not using Case Notes.
Entering Catalog Items, *continued*

**Standard Notes**

Click **Std. Notes** to attach a standard note to the PO line note.

With Standard Notes, you can search for an existing standard note, add a new note, edit a note, or remove a note.

Click **Insert on PO** to attach the note to the line.
Enter Non-Catalog Items

Steps

1. Double-click a blank PO line.

Result: The Item Information window displays.

2. Check the Non-Catalog box.

3. At a minimum, enter the system required fields and the 2 fields noted with *:
   - Item Description
   - Unit of Measure
   - Quantity
   - Deliver To
   - Cost Center (you know as Account number)
   - Expense Code (you know as Sub code)
   - Requisition Number*
   - Commodity Code*

4. Check the Auto Receive Item box.

5. Click **Close** when finished.
Enter Non-Catalog Items, continued

Non-Catalog validation

After entering the Vendor Catalog Number for a Non-Catalog item on a PO, the system searches the Item Manager to see if that Vendor Catalog Number already exists.

If a match is discovered, the following message displays:

![Item Master dialog box]

Click **OK** to replace the Non-Catalog item with the Catalog item.

Click **Cancel** to continue with the Non-Catalog item.

You should select the Catalog item in place of the Non-Catalog item whenever applicable.

Replicating Non-Catalog items

Non-Catalog items can be replicated by selecting **Line** then click **Replicate** from the menu bar.

Information is copied from the original Non-Catalog item. Modify fields as needed.
Pulling Requisitions on to a Purchase Order

Introduction

You have the ability to check to see if there are pending requisitions for a vendor while creating a purchase order. If pending requisitions are waiting to be pulled on to a purchase order, the Select Requisition Lines to add to a Purchase Order button is active.

Steps

Follow the steps below to pull requisition lines on to a purchase order:

1. Open Purchasing.
2. Enter Vendor and Corporation.
3. Complete the Cover Sheet.
4. Click the Select Requisition Lines to add to a Purchase Order button or go to the Line menu and click Select from Requisitions.
   
   Result: The Select from Requisitions window displays.
5. Search for pending requisitions.
6. Click Add All to select all pending requisitions for the vendor or select the requisition, then click Add To PO.
7. Modify purchase order as needed.
8. Submit purchase order.
Looking Up Vendor Information

Introduction

To view information about the vendor, select **Vendor Information** from the Information heading or click the Vendor Information icon.

Submit Types

Go to Vendor Information to change the submit type for a specific purchase order.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDI</td>
<td>PO is sent to the EDI server to be transmitted to the vendor.</td>
</tr>
<tr>
<td>Fax</td>
<td>PO is sent to the Fax server to be faxed to the vendor.</td>
</tr>
<tr>
<td>Phone</td>
<td>PO is saved in the system, buyer calls in the order.</td>
</tr>
<tr>
<td>Mail</td>
<td>PO automatically prints.</td>
</tr>
<tr>
<td>Supply Source</td>
<td>Send PO electronically via internet to a HSS vendor.</td>
</tr>
</tbody>
</table>
Resubmitting a PO

Introduction

Once a PO is submitted, certain changes are allowed. The PO may then be resubmitted to the vendor.

Resubmitted POs have the word “Modified” in the title bar of the printed copy and has a “Modified” column to show which lines were changed.

Resubmit change rules

General

• POs that were sent via EDI cannot be resubmitted via EDI.
• PO lines that have not been received or have only been partially received may be killed.
• Only the unreceived quantity of a line may be killed.

Once the PO has been received or partially received, the following is allowed:

• change the quantity of an item
• change the status of a line from On Order to Killed
• change the Project Code - Not applicable for UOR
• change the Delivery Date
• add an Item
• change Tax Information - Not applicable for UOR.

Once the PO is invoiced, the following is allowed:

• change quantity
• change status if the line is not fully received
• change Project Code - Not applicable for UOR
• change Delivery Date
• add an item.
Resubmitting a PO, continued

Steps

1. Select **File** from the menu bar, then click **ResSubmit**.

![File menu with ResSubmit highlighted](image1)

2. In the Activity Description window, enter a reason for each header or line change.

![Activity Description window](image2)

3. Click **Close**.

![Close button](image3)
Adding Line Allocations to a PO

Steps

The cost of a line can be allocated across multiple cost centers. This task can be completed in either the Purchasing application or Requisition application depending upon your security rights.

1  Open Purchasing application.
2  Add a line item.
3  Double click on the line to be allocated and select the Line Allocations tab.
4  Click the Allocations check box.
   Result: The GL account currently assigned to the line is filled in at 100%.
5  Change the allocation percentage or dollars for the default GL account.
6  Click Add to add another allocation to the line.
7  Enter another GL account and either the percentage of the cost, or the dollars to be allocated to the selected GL account.
8  Repeat Steps 6 and 7 as necessary.

Important:
All allocations must add up to equal 100% of the original line.
Chapter 8 - Requisitioning Profiles
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:

☒ create a PO using the requisitioning items.
Overview

Requisition flow process

The requisition process flow diagram.

- Items are added and the Requisition is submitted
- Non-Stock
- Non-Catalog
- Purchasing Request Bucket
- Baxter
  - Req Line
  - Req Line
  - Req Line
- Abbott
  - Req Line
  - Req Line
  - Req Line
- Owens & Minor
  - Req Line
  - Req Line
  - Req Line
- Unknown
  - Req Line
  - Req Line
  - Req Line

- Purchasing
- PO
Requisition Profiles

Introduction

The ability to pull requisitioned items on to a purchase order is referred to as PO Wizard. The function uses Requisition Profiles to identify requisition items that need to be added to a purchase order. There are two types of profiles:

<table>
<thead>
<tr>
<th>New Profile:</th>
<th>User defines specific criteria to identify requisition lines and to pull those lines onto a PO.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Profile:</td>
<td>Used to view all pending Requisition Lines per Corporation sorted by Vendor.</td>
</tr>
</tbody>
</table>

Steps

To create a PO from a Requisition Profile:

1. Open the Purchasing application and double-click your profile at the bottom of the Purchase Orders tab.
Requisition Profiles, continued

Result Page

Result: The Result Page displays.

2 Select the vendor.

3 Select the ship to location, requisition or item(s) to put on the PO, then click Finish. Result: The Save dialog box displays.

4 Click Yes, then name your profile.

Note: If you want to delete an item from the purchase order, right-click the PO line and click Delete. The item goes back to the requisition bucket to be pulled on to another PO. If the item needs to be removed from the bucket, pull it on to the PO, then change the PO line status to Killed.
Change the Vendor for an Item

Introduction
Requisition lines come into the Purchasing Request bucket with the Primary Vendor for that item assigned. At times you may want to assign another vendor to the item.

To Change a Vendor
Follow the steps below to change a vendor for an item:

1. Pull the item onto a PO.
2. Double-click the item to open the Item Information window.
3. Click the **Vendor Name** drop-down list, then select another vendor.

**Result:** The item no longer displays on the purchase order. It is now in the requisition bucket attached to the other vendor.

**Important:** This can only be done if more than one vendor is assigned to this item in the Item Manager.
Chapter 9 - Par Forms
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:

☐ create and maintain Par Level Inventory Forms.
Overview

Introduction

A Par Level refers to an optimal quantity of supplies kept in a point-of-use supply storage area called a Par Level Location.
Manual Process

Introduction

The following is an overview of the manual process to manage Par Levels. Each step will be detailed in the next pages.

1. Create a Par Level Inventory Form and save it assigning a unique name.
2. Print copies for the staff.
3. Inventory the Par Cart using the printed form.

Refer to each Inventory Departments individual Policy and Procedures regarding Creating/Editing Par Level Forms.
Manual Process Detail

Step 1: Creating a Par Level Inventory Form

The following are the steps to creating a Par Level Inventory form:

1. Click the **Par Level Management** icon.
2. Click the **Forms** tab.
3. Click the **New Form** icon.
4. Click the **Form Header Information** icon.

**Result:** The Form Header Information window displays.

![Form Header Information Window](image)

**Notes:**
Header Information must be completed prior to Item Entry.

5. Complete all appropriate boxes on the Form Header Information window.
6 Click **OK**.

**Result:** The Par Form Entry window displays.

![Par Form Entry Window]

7 Complete the item entry.

**Notes:** If the stocked flag is yellow, it indicates the item is stockless for the perspective supply location.

Use the **Tab** key to enter items and Par Levels.

Enter stock and non-stock items on the forms.

**Important:** Make sure to change the Par Level quantity to reflect the new UM. PMM does not change par quantities automatically. If the unit of measure has changed, you need to verify the quantities are correct with the new unit of measure.
8 Use the **Save** icon ![Save icon](image) to save the form.

Assign a unique name to the form.

**Important:** A par form **cannot** have the same name as a requisition template.

---

**Step 2: Print copies for the staff**

To print the form, use the print icon ![Print icon](image) within the form.

- **or**-

Print multiple forms at one time from the Reporting Application, Inventory Management category.

---

**Step 3: Inventory the par cart using the printed form**

The items list on the form in the order in which they were created.

Non-perpetual users, write on the form what you **need**.
Chapter 10 - Supply Location Information
Objectives

Learning Goals

Upon successful completion of this chapter, you will be able to:

- view on-hand quantity and unit of measure for an item in a supply location
- change an item’s unit of measure in a supply location
- add new items to a supply location
- inactivate items in a supply location.
Supply Location Information

Administration and Adjustments

The Administration and Adjustments functionality within the Inventory Management application allows you to manage the items located in a supply location. This information includes, setting the reorder theory for replenishment, entering the bin location(s) of where an item is located in the storeroom and viewing or adjusting the on-hand quantities of an item.

To access the supply item information:

1. Open Inventory Management.
2. Click the Inventory Control tab.
3. Double-click the Administration & Adjustments icon.

Result: The Administration & Adjustments window displays.

SMH and HH OR items will be pulled from PMM Supply Location into Picis. Therefore, it is imperative that the data in the Supply Locations is kept up to date. All items that need to appear in Picis must be entered in the Supply Locations for SHM and HH OR.
Supply Location Information, continued

Unit of Measure Changes

Every item has an **Issue** and an **Order** unit of measure. The units of measure can be the same or different depending on your Supply Location.

To change the Issue or Order unit of measure:

1. Select the item.
2. Select the Issue or Order unit of measure from the drop down list. Note: The available units of measure are dependent upon the packaging setup for the item in the Item Master table.
3. Click another line. **Result:** The save window displays.
4. Click **Save**.

The following table highlights the unit of measure change impact after saving the change:

<table>
<thead>
<tr>
<th>Issue Units of Measure</th>
<th>Order Units of Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact: On-hands are converted based on packaging.</td>
<td>Impact: Verify your min/max levels set for the item. Note: Non-perpetual areas’ vendor orders will not be placed from the Supply Location.</td>
</tr>
</tbody>
</table>

When you make a change to an item’s unit of measure (UM), the system validates and updates the UM in the Par Forms. Notify the person responsible for updating Par Forms of the change so they can adjust to par quantity.

Also, check the item’s reorder theory settings and make any necessary changes.
Supply Location Information, continued

Item Information

Click the Item Information icon or double-click the line item to display item specific information stocked in the supply location.

Result: Item Information window displays.

![Item Information Window]

It includes the following tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Detail</td>
<td>Stores the item’s asset account number and patient charge information. It displays the item detail stored in the Item Master.</td>
</tr>
<tr>
<td>Order Information</td>
<td>Stores the reorder theory information.</td>
</tr>
<tr>
<td>Bin Location</td>
<td>Stores the item’s bin location identifier.</td>
</tr>
</tbody>
</table>
Supply Location Information, continued

AutoSave feature

The AutoSave feature in the Administration & Adjustments application automatically saves item changes when you move to a new line or when you close Administration & Adjustments.

If AutoSave is not enabled, the system always prompts you to save changes. You receive a message giving you 30 seconds to save the change, otherwise the change is canceled.

The AutoSave setting is specific to a particular Supply Location.

To turn on AutoSave:

1. Open the Supply Location’s Administration & Adjustments application.
2. Click the Tools menu.
3. Select Enable AutoSave.

Note: A checkmark in front of Enable Auto Save indicates that it is on. To turn it off, repeat the above steps.

Adding items to a Supply Location

Follow these steps to add an item to a Supply Location:

1. Insert a line by selecting the button.
2. Enter the following information about the item:
   - Item Number
   - Cost Center and Account information
   - Patient Charge information (optional)
   - Reorder information - leave the field blank for non-perpetual areas
   - Bin Location(s).
3. Click Save.

Result: The item displays in the Supply Location.
Supply Location Information, continued

Inactivating items in a Supply Location

Inactive means the item will no longer be ordered or issued from the Supply Location.

To inactivate an item with zero on-hands:

1. Inactivate the item by selecting the button.
   
   Hint: The on-hand quantity must be 0 in order to inactivate the item.

2. Click another line to save your change and click **Save**.
   
   Note: If AutoSave is on, the system saves the change.

<table>
<thead>
<tr>
<th>What changed on the screen to alert the user that the item is inactive?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item is low-lighted</td>
</tr>
</tbody>
</table>

Pending inactive

If the item is still going to be issued until there is no remaining stock, then the item can have a status of Pending Inactive.

To inactivate an item that has a remaining on-hands quantity:

1. Select the button to set the status to Pending Inactive.

2. Click another line to save your change and click **Save**.

   Note: If AutoSave is on, the system saves the change.

<table>
<thead>
<tr>
<th>What changed on the item to alert the user that the item is pending inactive?</th>
</tr>
</thead>
<tbody>
<tr>
<td>P appears in left column</td>
</tr>
</tbody>
</table>